Global Targets
Local Benefits

Setting the Sustainable Development Agenda for the Seas of East Asia beyond 2015

16-21 November 2015

Pre-Congress Event

2nd International Training Program on Marine Ecosystem Services Valuation and Spatial Management Tools

CO-CONVENCING AGENCIES:

CO-SPONSORS:
1. BACKGROUND AND OBJECTIVES

1.1 In November 2013, a group of experts from Asian countries and Western communities had a meaningful meeting on ecosystem service valuation and its application to marine spatial planning and management. Organized by the Korea Maritime Institute (KMI) and Partnerships in Environmental Management for Seas of East Asia (PEMSEA), the experts shared experiences on ecosystem service valuation and development of spatial management tools, and discussed how to incorporate the valuation process into spatial planning and management mechanism. It was, in the Asian region, the first meeting on ecosystem service valuation and its application to spatial management. Participants recognized the importance of developing management tools, as well as capacity building on the use of these tools.

In line with efforts on capacity building, the 1st training program was organized in 2014 by the Korea Maritime Institute (KMI) in cooperation with PEMSEA, Marine InVEST and PacMARA. Twenty trainees from China, Cambodia, Indonesia Philippines, and RO Korea participated in the said training. Following the training, the 2nd International Workshop on Marine Ecosystem Valuation Spatial Management Tools was also organized. Issues were
identified in developing the management tools and institutionalizing them as part of the national policy regime.

At the workshop, enhancement of international networking and cooperation was firmly acknowledged as a common base that would contribute to tackling the issues.

Following the first training, the 2nd training program which was held as one of the pre-EAS Congress events on November 16, 2015 aimed to introduce participants on some of the valuation and spatial management tools applied in Korea and encourage more experts and practitioners to develop, adopt and apply these tools in their respective sites. It was emphasized that a more thorough training will be conducted in 2016 to discuss, in detail, the tools and methodologies.

The Training Program on Marine Ecosystem Valuation and Spatial Management Tools was attended by over 40 participants from various countries including Cambodia, China, DPR Korea, Lao PDR, Malaysia, RO Korea, Thailand, Timor Leste, United Kingdom, Vietnam, Indonesia and. The special pre-congress event brought together academia, government and practitioners to encourage the wider application of tools and methodologies in other sites and countries in the East Asian region and globally.

1.2 Dr. Jungho Nam of the Korea Maritime Institute (KMI) opened the training by highlighting the importance of the tools, their utilization at a local level, and the significance of this particular pre-congress event.

1.3 Mr. Stephen Adrian Ross, Executive Director of PEMSEA, reiterated Dr. Nam’s remarks, encouraging the participants to go beyond the training and facilitate the application of the tools on the ground. He encouraged KMI to develop the training into an annual event to strengthen knowledge and skills among the members of the PEMSEA Network of Learning Centers and other partners for application in new ICM sites.

1.4 A training kit was prepared by the KMI (Annex 1) which contains the updated program, MS PowerPoint presentations made during the training as well as the list of participants.

2. **COURSE 1: MARINE ASSESSMENT AND PLANNING SUPPORT SYSTEM-MARINE SUITABILITY ASSESSMENT (MAPS-MSA)**

2.1 Dr. Nam (KMI) presented an overview of the purpose of Marine Suitability Assessment and how it can be utilized to support decisionmaking on coastal and marine spatial planning and management. He highlighted how it can be applied to ICM local plans and then provided an overview of the major steps which include the preparation, planning area delineation & grid setting, data collection and pre-processing, score calculation & integration, standardization of scores, and spatial classification. Dr. Nam took the participants through a case study of
Gamak-bay, RO Korea, indicating how each of the major steps were applied to a real-world situation. He concluded the course by discussing the potential applications of MAPS-MSA which included zoning, Environmental Impact Assessments, and designation of Marine Uses.

3. COURSE 2: MARINE ASSESSMENT AND PLANNING SUPPORT SYSTEM-SPATIAL ECOSYSTEM VALUATION (MAPS-SEV)

3.1 Professor. Daesok Kang of Pukyong National University, focused on Ecosystem Service Valuation and how the concept of Emergy can be utilized as a biophysical approach to The Economics of Ecosystems and Biodiversity (TEEB) – a global initiative focused on “making nature's values visible”. Prof. Kang explained how energy could be used as a common currency to compare different resources.

In using a biophysical approach to value the contributions of ecosystem services to the wealth of the economy, it attempts to include both human and nature’s contributions in producing these services. He explained that emergy evaluates the work previously done to make a product or service and that it measures energy used in the past making reference to solar emergy, wind emergy and gold emergy.

Examples of emergy indices such as population carrying capacity and the Emergy sustainability index (ESI) were also explained. Prof. Kang went on to elaborate how Emergy valuation using spatial information on natural capital and ecosystem services of marine and coastal ecosystems could be useful in decisionmaking in marine spatial planning. He discussed the tools (GIS and MS Excel) needed for MAPS-SEV implementation and who should be involved in the MAPS-SEV process.

Prof. Kang took participants through the process using a case study of Gyeonggi Bay, RO Korea, which was chosen as a demonstration site for MAPS-SEV as there were multiple uses and conservation needs in the area, as well as heavy development pressure. In conclusion, he presented the potential uses of ecosystem value maps produced by MAPS-SEV which included spatial decision making on priority conservation areas, trade-off analysis, reference data for potential compensation and environmental taxes, integration of natural capital and ecosystem services into EIA’s, cost-benefit analysis of development proposals, raising awareness and education on the importance of marine and coastal ecosystems.

4. COURSE 3: MARINE INTEGRATED VALUATION OF ENVIRONMENTAL SERVICES AND TRADEOFFS (INVEST)

4.1 Dr. Choong-Ki Kim of the Korean Environment Institute (KEI) gave an introduction to Natural Capital Approach and described ecosystem service assessment tools such as ARIES, ESVValue, EcoMetrix and InVest. Dr. Kim focused on InVest as a tool to quantify, map and value the benefits provided by terrestrial, freshwater and marine systems. He provided examples of
InVEST Models which are useful for examining how actions taken today play out into the future through the use of scenarios. Dr. Kim demonstrated how InVEST was utilized for marine spatial planning using two examples. The first made reference to MSP in Vancouver Island, Canada using recreation and tourism data. The second demonstrated how InVEST was used to develop an integrated coastal zone management plan in Belize and to use the tool for future EIA assessments for the coastal zone. Finally, Dr. Kim presented a case study on the issue of natural capital management in Jeju and how an ecosystem service model could be applied for decisionmaking.

5. CLOSING OF THE TRAINING PROGRAM

5.1 In closing, Dr. Nam of KMI stated that this one-day training program only provided an introduction to the tools presented. He announced the call for applications to the 3rd Training Program on Marine Ecosystem Services and Spatial Planning Tools to be held in the second quarter of 2016 in Busan, RO Korea, which aims to strengthen the understanding of implementers and professionals on the various decision-support tools for marine valuation and marine spatial planning. As part of the training, hands-on exercises will be conducted by trainers to familiarize the participants on the tools and how these can be used in marine spatial planning. Further, participants were encouraged to submit abstracts to the 4th International Workshop on Marine Ecosystem Services and Spatial Planning which will focus on the challenges and perspectives in mainstreaming marine ecosystem services into marine spatial policy of coastal states. Full papers from the event are expected to be published in a special edition of international journals.

6. SUGGESTIONS MADE TO IMPROVE THE NEXT FULL TRAINING PROGRAM

6.1 Dr. Nam encouraged participants to provide suggestions on how the next training program can be more effectively conducted. The following were provided during the training. CCRES also provided some input after the training, for consideration of the KMI:

- Longer period for training to cover the topics more thoroughly. KMI should also consider two levels of training for technical staff (longer) and for decisionmakers/policymakers (1 day)

- Proper targeting of participants for technical training to ensure that participants will have basic knowledge, for instance on GIS, in the case of mapping.

- Identifying topics and tools for training, and focusing on those which has wider acceptance. The training on EMERGY should be carefully reconsidered considering its acceptance among implementers.

6.2 At the end of the training, training certificates were provided to the participants by KMI.
ANNEX
TRAINING KIT
2nd International Training Program on Marine Ecosystem Services Valuation and Spatial Management Tools

Da Nang City, Viet Nam • 16 November 2015
2nd International Training Program on
Marine Ecosystem Services Valuation and
Spatial Management Tools

Da Nang City, Viet Nam • 16 November 2015

Organized by
Korea Maritime Institute
&
Partnership in Environmental Management for Seas of East Asia

Sponsored by
Ministry of Oceans and Fisheries
&
Korea Marine Environment Management Corporation
Copyright: © 2015 Korea Maritime Institute
Suggested Citation: Korea Maritime Institute (KMI), 2015. Training Material for the 2nd International Training Program on Marine Ecosystem Services Valuation and Spatial Management Tools. Korea Maritime Institute, Busan, Korea.
Contents

1. Introduction of 2nd Training Program / 5

2. Course 1: Marine Assessment and Planning Support System
   – Marine Suitability Assessment (MAPS-MSA) / 11

3. Course 2: Marine Assessment and Planning Support System
   – Spatial Ecosystem Service Valuation (MAPS-SEV) / 43

4. Course 3: Marine InVEST / 91

Appendix 1: Integrated Coastal Management of RO KOREA / 127
Appendix 2: Contributors of the Training Program / 133
Appendix 3: Trainees of 2nd Training Program / 141
Introduction of 2nd Training Program
1. Backgrounds and Objectives

A group of experts from Asian countries and Western communities, in November of 2013, had a meaningful meeting on ecosystem service valuation and its application to marine spatial planning & management. The experts shared experiences on ecosystem service valuation and development of spatial management tools, and discussed how to incorporate the valuation process into spatial planning & management mechanism. It was, in Asian region, the first meeting dealing with ecosystem service valuation and its application to spatial management. All attendants recognized importance of development of sophisticated management tools, and as well capacity building.

In line with capacity building, the 1st training program was organized by Korea Maritime Institute (KMI) in cooperation with PEMSEA, Marine InVEST and PacMARA. 20 trainees participated in the training program from Korea, China, Cambodia, Indonesia Philippines, and enjoyed learning of spatial management tools developed by KMI, Marine InVEST, and PacMARA. Organizers and trainers had encouraged trainees to challenge a development of the tools for their countries. Also, all trainees and experts attended the 2nd International Workshop on Marine Ecosystem Valuation and Spatial Management Tools. Issues were identified in developing the management tools and institutionalizing them in national policy regime. Enhancement of international networking and cooperation was firmly acknowledged as a common base that would contribute to tackling the issues.

Trainees and experts will also attend the 3rd International Workshop on Marine Ecosystem Valuation and Spatial Management Tools to discuss the linkage between valuation of coastal ecosystem services and benefits and coastal use zoning and other tools, and how they are used to support better planning and management of coastal and marine areas and resources, to provide social and economic benefits for coastal communities.
2. Program

<table>
<thead>
<tr>
<th>Time</th>
<th>Activity</th>
</tr>
</thead>
<tbody>
<tr>
<td>08:00</td>
<td><strong>REGISTRATION</strong></td>
</tr>
<tr>
<td>08:30</td>
<td>Opening Ceremony and Introduction to the program</td>
</tr>
<tr>
<td>08:30</td>
<td>Opening Ceremony</td>
</tr>
<tr>
<td></td>
<td>- Opening Remarks (KMI)</td>
</tr>
<tr>
<td></td>
<td>- Welcoming Remarks (PEMSEA)</td>
</tr>
<tr>
<td></td>
<td>- Congratulatory Remarks (MOF, RO Korea)</td>
</tr>
<tr>
<td></td>
<td>- Congratulatory Remarks (KOEM, RO Korea)</td>
</tr>
<tr>
<td>08:50</td>
<td>Introduction to the program</td>
</tr>
<tr>
<td></td>
<td>- Backgrounds and Objectives</td>
</tr>
<tr>
<td></td>
<td>- Overview of the course</td>
</tr>
<tr>
<td></td>
<td>- Expected outputs</td>
</tr>
<tr>
<td>09:00</td>
<td>Course 1: Marine Assessment and Planning Support System</td>
</tr>
<tr>
<td></td>
<td>- Marine Suitability Assessment (MAPS-MSA)</td>
</tr>
<tr>
<td>09:00</td>
<td>Instructor: Dr. Jungho NAM (Korea Maritime Institute)</td>
</tr>
<tr>
<td></td>
<td>- Introduction of Marine Suitability Assessment (MSA)</td>
</tr>
<tr>
<td></td>
<td>- Overview of major steps in MSA application</td>
</tr>
<tr>
<td></td>
<td>- Preparation for assessment</td>
</tr>
<tr>
<td></td>
<td>- Planning area delineation</td>
</tr>
<tr>
<td></td>
<td>- Data collection &amp; pre-processing</td>
</tr>
<tr>
<td></td>
<td>- Score Calculation &amp; Integration</td>
</tr>
<tr>
<td></td>
<td>- Standardization of scores</td>
</tr>
<tr>
<td></td>
<td>- Spatial classification</td>
</tr>
<tr>
<td></td>
<td>- Application for spatial planning</td>
</tr>
<tr>
<td></td>
<td>- GIS Toolkit for MAPS-MSA</td>
</tr>
<tr>
<td></td>
<td>- The Case study of Gamak-bay</td>
</tr>
<tr>
<td>10:30</td>
<td><strong>Refreshment</strong></td>
</tr>
</tbody>
</table>
Course 2: Marine Assessment and Planning Support System
- Spatial Ecosystem Service Valuation (MAPS-SEV)

11:00 – 12:30
Instructor: Prof. Daeseok KANG (Pukyong National University)

- Emergy Methodology - Energy Concept & Emergy Evaluation Procedure
- Overview of MAPS-SEV – Structure, Tools Needed, Procedure, Participants
- Valuation Boundary Delineation
- Issue Identification
- Data Collection
- Map Preparation – Process overview, Base map preparation, Raw data file preparation, Spatial interpolation, Spatial grid construction
- Spatial Emergy Mapping - Intermediate data calculation, Emergy calculation, Emvalue calculation, Emergy maps
  * The case study of the Gyeonggi Bay
- Application of MAPS-SEV

12:30 – 14:00
Lunch

Course 3: Marine InVEST

14:00 – 15:30
Instructor: Dr. Choong-Ki KIM (Korea Environment Institute)

- Natural Capital – Concepts, methods and initiatives
- InVEST (Integrated valuation of environmental services and tradeoffs)
- Marine Spatial Planing using InVEST Models
- Ecosystem Service Model Applications for Decision Making
  * The case study of Jeju Island

Wrap-up of the Training Program

15:30 – 16:00
Dr. Jungho NAM (Korea Maritime Institute)

- Wrap-up
- Presentation certificate & Introduction to 3rd training program
- Closing of the 2nd training program
Course 1:
Marine Assessment and Planning Support System
- Marine Suitability Assessment (MAPS-MSA)
MAPS-MSA

(Marine Assessment & Planning Support system - Marine Suitability Assessment)

Instructor
Jungho Nam, Korea Maritime Institute

Contributors
Jungho Nam, Korea Maritime Institute
Jongseo Lim, Seoul National University
Heejung Choi, Korea Maritime Institute
I. Introduction

Marine Suitability Assessment
**Objective**

- Supporting decision-making on coastal & marine spatial planning and management
  - coastal seawater zoning
  - site designation for specific uses
  - screening & scoping in EIA & SEA

---

**Application to ICM local plans**

- Mayors: preparation of plans
  - determination and changes of use zones on ICM local plans
- Minister, MOF
  - review and approval of the local plans

Amendment of Coastal Management Act in 2009

Stakeholders’ involvement
Overview of Major Steps

- Preparation
- Area delineation & Grid setting
- Data collection & pre-processing
- Score calculation & Integration
- Standardization of scores
- Spatial Classification

- Team building & platform decision
- Geographic boundary delineation
- Determination of grid scales
- Environmental characteristics
- Seawater spatial uses
- Neighborhood influence
- Scores of individual para. on each grid
- Integration of all scores on each grid
- Standardization of all scores of each grid
- Conservation vs. Exploitation/development

II. Following Assessment Steps

1. Preparation
2. Planning area delineation & Grid Setting
3. Data collection and pre-processing
4. Score calculation & Integration
5. Standardization of scores
6. Spatial classification

2nd International Training at EAS Congress 2015
1. Preparation for Assessment

Technical Team Building

Assessment Platform Determination

ArcGIS

**Pros**

- Extensive technical support resources
- Powerful & user-friendly inventory setting of tools and data
- All-in-one & one-stop software package
2. Planning Area Delineation

Area Delineation & Grid Setting

- Boundary delineation
  - Entire jurisdiction area or specific boundary for controversial issues

- Assessment Grid Setting
  - area size, geographic/environmental/socio-economic characteristics

Basal grid & secondary grid (single or mixed grid settings)

3. Data collection & pre-processing

Identification of Issues & Major Features

- Ecological Issues & Features: Change of ecosystem
  - corals, mangroves, tidal flats, protected species, water quality etc (degradation, loss & risks)

- Socio-economic Issues & Features: Change of society
  - Local economic condition, livelihoods, coastal economic activities etc
Parameter Setting & Data/Information Collection

- Basic Data: base maps (digital maps)
  - coastline, coastal lands and seawaters

- Assessment Parameter Set & Data/information collection
  - 1st Tier
    - Environmental Characteristics, Spatial Uses, Neighborhood Influence
  - 2nd Tier: sub-parameters of each category on 1st Tier

- Collection of available data/information

Data/Information Confirmation for Assessment

- Representativeness
  - legal/institutional, ecological, socio-economic characteristics representing the planning area

- Availability
  - low priority on less available or less qualified data/information
    - Alternative data: remote-sensing, global scale statistic data etc

- Applicability: data type
  - Geocoded Data (CAD, shp, KML files) / drawings / sheets (Excel)
Examples of Confirmation and Applicability

<table>
<thead>
<tr>
<th>Categories &amp; Parameters</th>
<th>Description</th>
<th>Data Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected Species and their Habitats</td>
<td>Protected species, endangered species, natural monuments etc</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Water Quality</td>
<td>COD-based classification (10 year’s averaged)</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Tidal Wetlands</td>
<td>Tidal flats or wetlands / mangroves</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Distinguished CoastalScapes</td>
<td>Classification of all types of landscapes</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Estuarine Areas</td>
<td>Legally designated landscape areas</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Uses and occupation of public owned waters</td>
<td>Accumulated uses on each grid during last 1 year</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Protected Areas</td>
<td>Influence on marine &amp; coastal protected areas</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Terrestrial areas</td>
<td>Influence from land-based activities</td>
<td>![ ]  ![ ]</td>
</tr>
<tr>
<td>Development areas</td>
<td>Influence from development projects</td>
<td>![ ]  ![ ]</td>
</tr>
</tbody>
</table>

Preprocessing & weighting factor setting

- **Data preprocessing**
  - transforming point data to polygon data (ex. extra- or interpolation)

- **Weighting factor setting**
  - WF differentiation based on ecological and socio-economic relevance

**Intersubjective approach**
- Expert judgement
- stakeholder consultation
### Score Calculation on each Grid

<table>
<thead>
<tr>
<th>Categories and Parameters</th>
<th>Score</th>
<th>1st</th>
<th>2nd</th>
<th>3rd</th>
</tr>
</thead>
<tbody>
<tr>
<td>Protected Species</td>
<td></td>
<td>&lt; 500m</td>
<td>&lt; 1,000m</td>
<td>&gt; 1,000m</td>
</tr>
<tr>
<td>Water Quality Class</td>
<td></td>
<td>1st</td>
<td>2nd</td>
<td>3rd</td>
</tr>
<tr>
<td>Ratio of Tidal Wetlands</td>
<td></td>
<td>&gt; 50% on grids</td>
<td>0~50%</td>
<td>0%</td>
</tr>
<tr>
<td>1st Class landscape or legally designated areas</td>
<td>On grids</td>
<td>Neighboring grids</td>
<td>Other grids</td>
<td></td>
</tr>
<tr>
<td>Estuarine Proximity</td>
<td></td>
<td>&lt; 1,000m</td>
<td>&lt; 2,000m</td>
<td>&gt; 2,000m</td>
</tr>
<tr>
<td>Spatial Uses</td>
<td></td>
<td>0% on grids</td>
<td>0~20%</td>
<td>&gt; 20%</td>
</tr>
<tr>
<td>Ratio of uses/occupation Fishing rights</td>
<td>Coastal &amp; Marine PAs</td>
<td>On grids</td>
<td>&lt; 1,000m</td>
<td>&gt; 1,000m</td>
</tr>
<tr>
<td>Neighborhood Influence</td>
<td></td>
<td>Land area</td>
<td>&gt; 2,000m</td>
<td>&lt; 2,000m</td>
</tr>
<tr>
<td>Development Area</td>
<td></td>
<td>&gt; 2,000m</td>
<td>&lt; 2,000m</td>
<td>&lt; 1,000m</td>
</tr>
</tbody>
</table>

#### Integration of suitability scores

- Integration of individual parameter’s score on each grid
  - \( m \), a number of parameters
  - \( i \), \( i \)th grid

\[
S_i = \sum_{n=1}^{m} P_{ni} \quad \text{without WF}
\]

\[
S_i = \sum_{n=1}^{m} w_n P_{ni} \quad \text{with WF}
\]
5. Standardization of scores

Standardization of Suitability Assessment Scores

- Z-score by using Mean and Standard Deviation of integrated scores on each grid

\[
Z_i = \frac{S_i - \bar{S}}{\sigma}
\]

6. Spatial Classification

- Transformation of standardized scores (SS) into suitability class
  - Conservation: SS ≥ 0
  - Uses/Development: SS < 0

- Shifting of the curve for policy environment
  - allowable shifting range: ±1
7. Application for Spatial Planning

- Zoning
- EIA & SEA
- Permission & license issuance
- Site designation for specific needs (protection or development)

III. Analyzing with GIS Toolkits

Toolbox form of ArcGIS
Case study of Gamak Bay
Toolbox Design at ArcGIS

• Toolset design based on assessment flow
  - Modification of automated stepwise models
  - Resetting variables' values

Assessment Flow

1. GIS Toolkit for MAPS MSA

2. Environmental Conditions
   - 01.ProtectedSpecies
   - 02.WaterQuantity
   - 03.TotalNut
   - 04.ScienicSpot
   - 05.Others
3. Spatial Uses
   - 01.FishingLicense
4. Neighborhood Influences
   - 01.DistanceимRoad
   - 02.DistanceиmR.D
5. Evaluation
   - 01.Cumulation
   - 02.Standardization

Area Delineation
Grid Setting
Assessment
Integration
Classification
2. Case study of Gamak-bay

0. Environmental setting

- Installation of ArcGIS
  - ArcGIS 9.3 recommended for MAPS-MSA application

0. Environmental setting (cont.)

- Locating the Tutorial folder
  - The tutorial folder should be located under ‘C:\MAPS_MSA’ folder
Analyzing with GIS Toolkits

(2. Case study of Gamak-bay)

0. Environmental setting (cont.)

- Load the MAPS_MSA toolkit
  - Add an ‘ArcToolbox Window’ by clicking a GUI button in an editor toolbar
  - Add a ‘MAPS_MSA toolbox’ from ArcToolbox menu (click the right mouse button for pop-upping the menu)
  - The toolbox file with a name of ‘MAPS_MSA_Toolbox.tbx’ is located in the tutorial folder

(1) Regional Setting

- Selection and delineation of the planning area
  - preparation of base maps for coastal waters and lands
- Add data by button
  - Load ‘BasicData.lyr’ file that located in ‘BasicDataWLayerW’ of the Tutorial folder
(2) Data File Loading

- **Data/information Preparation**
  - Acquired from legally-binding regular surveys in this study

- **Add data by button**
  - Load ‘Properties.lyr’ file located in ‘BasicDataWLayerW’ of the Tutorial folder

(3) Grid Setting

- **Generate an assessment grid**
- **Input Data for grid generation**
  - Land polygon
  - Water polygon
- **Expected Output Data**
  - Grid polygon
(3) Grid Setting (cont.)

Step 1: 100m grid buffer layer
- generate a buffer layer within 1,000 m from coastlines
- applied for 100m grid set area
(2) Case study of Gamak-bay

(3) Grid Generation (cont.)

Step 2: 500m grid buffer layer
- generate a buffer layer in 1 km ~ 10 km from coastlines
- applied for 500m grid set area

(2) Case study of Gamak-bay

(3) Grid Setting (cont.)

Input Data
- Water Polygon of Research Area
  - C:\MAPS_MSA\Tutorial\BasicData\Vector\GamakBay.shp
- 100m Buffer Polygon
  - C:\MAPS_MSA\Tutorial\Processed\Data\GamakBay_Buffer_100m.shp
- Land Polygon of Research Area
  - C:\MAPS_MSA\Tutorial\BasicData\Vector\CadastalLand_GamakBay.shp
- Output Polygon
  - C:\MAPS_MSA\Tutorial\Processed\Data\GamakBay_Buffer_Remnant.shp
Step 3: Grid layer generation

- Build grid files of 100m & 500m intervals by Hawth's Tools tool
Step 4: Merging grid layers
• Merging layers of each grid set area by the MAPS_MSA tool

2nd International Training at EAS Congress 2015
(4) Assessment

- **Input Data: polygons**
  - Data/information of parameters
  - Point data: transformed to polygon type data through buffering or extrapolation

- **Output Data**
  - Scores of individual parameter on each grid

(4) Assessment – Environmental Characteristics

- Legally protected species
  - Point data on observed sites
  - 1: < 500 m from observed sites
  - 0: < 1,000 m from the sites
  - -1: > 1,000 m from the sites
(2) Case study of Gamak-bay

(4) Assessment – Environmental Characteristics (cont.)

- Water Quality Class
  - Extrapolating point data of COD class
  - 1: 1st class water quality
  - 0: 2nd class WQ
  - ~1: 3rd Class WQ
2. Case study of Gamak-bay

(4) Assessment – Environmental Characteristics (cont.)

- Tidal wetlands
  - Polygon data on wetlands’ survey
    - 1: > 50% coverage of grid size
    - 0: < 50% coverage
    - -1: zero coverage
2. Case study of Gamak-bay

(4) Assessment – Environmental Characteristics (cont.)

- CoastalScape condition
  - Polygon data on 1st class landscape area or legally designated landscape zones
  - 1: including the area / zones
  - 0: adjacent to the area/zones
  - -1: other grids
(2) Case study of Gamak-bay

(4) Assessment – **Environmental Characteristics** (cont.)

- **Estuarine Proximity**
  - Distance to grids from sea-river boundary
    - $1$: $< 1,000$ m from the boundary
    - $2$: $< 2,000$ m
    - $3$: $> 2,000$ m
(4) Assessment – Environmental Characteristics (cont.)

(4) Assessment – Spatial Uses

- Spatial uses
  - Polygon data on fishing rights

  - 1: 0% coverage of a grid size
  - 0: < 20% coverage
  - 1: > 20% coverage
(2. Case study of Gamak-bay)

(4) Assessment – *Spatial Uses* (cont.)

![GIS Toolkits for Spatial Uses](image1)

(4) Assessment – *Neighborhood Influence*

- Distance from coastlines
  - Polygon data on coastlines
    - 1: > 2,000 m from the line
    - 0: < 2,000 m
    - -1: > 1,000 m
(4) Assessment – *Neighborhood Influence* (cont.)

- Distance from development planning sites/area
  - polygon data on land use plans of local governments
  - \( i > 2,000 \text{ m from sites/areas} \)
  - \( o < 2,000 \text{ m} \)
  - \( -i > 1,000 \text{ m} \)
2. Case study of Gamak-bay

(4) Assessment – Neighborhood Influence (cont.)

3. Analyzing with GIS Toolkits

(5) Integration

- Integration of individual parameter’s score on each grid
  - $m$, a number of parameters
  - $i$, $i$th grid

$$S_i = \sum_{n=1}^{m} P_{ni} \text{ without WF}$$
(5) Integration (cont.)

(6) Standardization of Suitability Assessment Scores

- Z-score by using Mean and Standard Deviation of integrated scores on each grid

\[ Z_i = \frac{S_i - \bar{S}}{\sigma} \]
(2) Case study of Gamak-bay

(6) Standardization of Suitability Assessment Scores (cont.)

- Transformation of standardized scores (SS) into suitability class
  - Conservation: SS $\geq 0$
  - Uses/Development: SS $< 0$

- Shifting of the curve for policy environment
  - allowable shifting range: $\pm 1$
Course 2:
Marine Assessment and Planning Support System
- Spatial Ecosystem Service Valuation (MAPS-SEV)
MAPS-SEV

( Marine Assessment & Planning Support system - Spatial Ecosystem service Valuation )

Instructor
Daeseok Kang, Pukyong National University

Contributors:
Daeseok Kang, Pukyong National University
Jungho Nam, Korea Maritime Institute
Hyun-Woo Choi, Korea Institute of Ocean Science and Technology
Kyuhee Son, Korea Marine Environment Management Corporation
Contents

I. Emergy Methodology
II. Overview of MAPS-SEV
III. Valuation Boundary Delineation
IV. Issue Identification
V. Data Collection
VI. Map Preparation
VII. Spatial Emergy Mapping
VIII. Application of MAPS-SEV

I. Emergy Methodology

1. Energy Concept
2. Emergy Evaluation Procedure
Relationship between real wealth and market price

Real wealth = products of work (Odum, 1996)
- clothes, books, food, minerals, fuels, information, art, technology, species, electricity, biodiversity, etc
- produced and maintained by work processes from the environment, sometimes helped by people

Ecosystem service valuation and Emergy

Source: TEEB (2010)
Ecosystem valuation and Emergy

- Any other common denominators instead of money?
  - energy as an alternative because it is involved in every processes on earth

- Energy Memory, Energy History
  - Use energy as a common currency to compare vastly different resources

- Definition: Available energy of one kind previously required directly and indirectly to make a product or service (Odum, 1996)
  - Unit: emjoules
  - Solar emergy: Available solar energy used up directly and indirectly to make a service or product (Unit: solar emjoules, sej)

- Biophysical approach in valuing contributions of ecosystem services to the real wealth of our economy
  - An effort to include both human efforts and nature’s work put into the production of ecosystem services

Emergy Valuation vs Economic Valuation
I-1. Emergy concept

Emergy Valuation vs Economic Valuation

Sources of donor value

Production

Willingness to pay

Receiver

Receiver value:
Concept of a value originating from receiver perceptions

Emery value:
Concept of a donor value originating from required inputs

Source: Odum (1996)

Energy quality concept

- How do we compare different things?
- How much money do I have?
  - $100 + ¥100 + €100 + ¥100 = 400 ???
    - Conversion factors needed to compare different things
  - Exchange rate as a conversion factor to compare different currencies
    - $100×1,040.90W/$ + ¥100×1,414.16W/¥ + €100×10.18W/€
    = ¥246,624 (Exchange rate as of June 18, 2014)
Energy quality concept
- Energy of one kind is not equivalent in its ability to do work to energy of another kind
  - Different ability to do work
  - Conversion factors are needed to compare different energies
    - Reference energy equivalent

Unit emergy value: the conversion factors with solar energy as the reference
- Transformity (sej/J), specific emergy (sej/g), emergy-money ratio (sej/$), etc

<table>
<thead>
<tr>
<th>Energy</th>
<th>Transformity (sej/J)</th>
<th>Specific Emergy (sej/g)</th>
<th>Emergy-Money Ratio (sej/$)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sun</td>
<td>1</td>
<td>Odum (2000)</td>
<td></td>
</tr>
<tr>
<td>Wind</td>
<td>2,450</td>
<td>Odum (2000)</td>
<td></td>
</tr>
<tr>
<td>Rain</td>
<td>30,500</td>
<td>Odum (2000)</td>
<td></td>
</tr>
<tr>
<td>Wave</td>
<td>51,000</td>
<td>Odum (2000)</td>
<td></td>
</tr>
<tr>
<td>Tide</td>
<td>73,900</td>
<td>Odum (2000)</td>
<td></td>
</tr>
<tr>
<td>Iron ore</td>
<td>5.78 × 10^9</td>
<td>Cohen (2005)</td>
<td></td>
</tr>
<tr>
<td>Gold</td>
<td>5.04 × 10^11</td>
<td>Cohen (2005)</td>
<td></td>
</tr>
<tr>
<td>EMR for Korea in 2011</td>
<td>5.36 × 10^12</td>
<td>Kang (2013)</td>
<td>12</td>
</tr>
</tbody>
</table>

Calculation of emergy and unit emergy value

Solar emergy of harvested fish = Sum of all emergy inputs
A (or B, C) + D + E

Solar transformity (sej/J) = Emergy / energy content of harvested fish
I-1. Emergy concept

Emergy and Money

- Emvalue: em$, emW, etc
  - Money equivalent of emergy
  - Emergy is converted to a money unit to be compared with other works that provide monetary quantities on the value of ecosystems and resources

- Emergy-money ratio (EMR) = Total emergy used in an economy / GDP
  - Unit: sej/$, sej/W, etc
  - EMR of Korea in 2011: 5.36×10^{12} sej/$
    - Total emergy use (5.98×10^{24} sej/yr) / GDP (1.11×10^{12} $/yr)

- Emvalue = Emergy flow / Emergy-money ratio
  - Emvalue of tidal energy in Korea in 2011 = 5.40×10^{10} em$/yr
    - (2.89×10^{23} sej/yr) / (5.36×10^{12} sej$/)

I-2. Emergy Evaluation Procedure

Procedure for environmental accounting with emergy

- Energy systems diagramming
- Construction of emergy evaluation table
- Calculation of emergy indices

Selection of a site to be evaluated

Delineation of the site boundary

Energy system diagramming

Construction of emergy evaluation table

Calculation of emergy indices

Analysis of the evaluation results
Energy systems diagramming

Delineation of the system boundary

Identification of outside sources

Identification of internal components

Identification of major flows

Interconnection of sources and components

I-2. Emergy Evaluation Procedure

Energy systems diagramming steps (Odum, 1996)

- Define the boundary of the window of the systems overview, thus separating the internal components and processes from the influences from outside that boundary.
- List the important sources (external causes, external factors, and forcing functions). Importance means that an effect is suspected to be 5% or more of the total system function.
- List the principal components within the boundary and units believed to be important considering the scale of the system defined.
- List the processes (flows, relationships, interactions, production and consumption processes, and so on). Include flows and transactions of money believed to be important.
- Draw the systems diagram, starting with the external sources arranged around the rectangular frame marking the boundary. Draw in the symbols for components. Arrange sources and components in order of transformity from left to right. Then connect pathways between the symbols.
Energy systems diagramming


Maps-SEV

I-2. Emergy Evaluation Procedure

Energy systems diagram for the Gyeonggi Bay, Korea

Maps-SEV

I-2. Emergy Evaluation Procedure
Construction of emergy evaluation table

Typical format for the table

<table>
<thead>
<tr>
<th>Note</th>
<th>Item</th>
<th>Data</th>
<th>Unit Emergy Value (solar transformity, specific emergy, etc)</th>
<th>Solar Emergy</th>
<th>Emvalue</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Sun</td>
<td>J/yr, g/yr, $/yr, etc</td>
<td>sej/J, sej/g, sej/$, etc</td>
<td>sej/yr</td>
<td>em$/yr, emW/yr, etc</td>
</tr>
</tbody>
</table>

Emergy evaluation table for the Gyeonggi Bay

<table>
<thead>
<tr>
<th>No.</th>
<th>Item</th>
<th>Raw Data</th>
<th>UEV</th>
<th>UEV Source</th>
<th>Solar Emergy (se/yr)</th>
<th>Emvalue</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Environmental inputs</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1</td>
<td>Sunlight</td>
<td>1.60E+19</td>
<td>J/yr</td>
<td>1</td>
<td>sej/J</td>
<td>1.60E+19</td>
</tr>
<tr>
<td>2</td>
<td>Wind</td>
<td>1.37E+16</td>
<td>J/yr</td>
<td>2450</td>
<td>sej/J</td>
<td>3.35E+19</td>
</tr>
<tr>
<td>3</td>
<td>Rain, chemical</td>
<td>2.43E+16</td>
<td>J/yr</td>
<td>30500</td>
<td>sej/J</td>
<td>7.41E+20</td>
</tr>
<tr>
<td>4</td>
<td>Wave</td>
<td>3.03E+15</td>
<td>J/yr</td>
<td>51000</td>
<td>sej/J</td>
<td>1.54E+20</td>
</tr>
<tr>
<td>5</td>
<td>Tide</td>
<td>3.52E+17</td>
<td>J/yr</td>
<td>73900</td>
<td>sej/J</td>
<td>2.60E+22</td>
</tr>
<tr>
<td>6</td>
<td>River, chemical</td>
<td>2.02E+17</td>
<td>J/yr</td>
<td>81300</td>
<td>sej/J</td>
<td>1.64E+22</td>
</tr>
<tr>
<td></td>
<td>Storage</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>7</td>
<td>Benthos</td>
<td>4.17E+15</td>
<td>J</td>
<td>3.30E+06</td>
<td>sej/J</td>
<td>1.37E+22</td>
</tr>
<tr>
<td></td>
<td>Ecosystem services</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>8</td>
<td>Fishery production</td>
<td>7.62E+12</td>
<td>J/yr</td>
<td>8.40E+06</td>
<td>sej/J</td>
<td>6.40E+19</td>
</tr>
<tr>
<td>9</td>
<td>Marine sand extraction</td>
<td>6.25E+06</td>
<td>g/yr</td>
<td>2.13E+09</td>
<td>sej/g</td>
<td>1.33E+16</td>
</tr>
</tbody>
</table>
I-2. Emergy Evaluation Procedure

Calculation of emergy indices

To understand the characteristics of a system under consideration

![Diagram of emergy evaluation process]

Emergy Yield Ratio (EYR) = Y / F
Emergy Investment Ratio (EIR) = F / (R + N)
Environmental Loading Ratio (ELR) = (N + F) / R
Emergy Sustainability Index (ESI) = EYR / ELR

Examples of emergy indices

<table>
<thead>
<tr>
<th>Emergy indices</th>
<th>Definitions (Odum, 1996)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Emergy-money ratio (EMR)</td>
<td>Total emergy use of a system divided by gross domestic product. It shows the buying power of money of a system in terms of real wealth. Decrease in EMR indicates decrease in the amount of real wealth that the currency of the system under consideration could buy.</td>
</tr>
<tr>
<td>Emvalue</td>
<td>Emergy of products divided by the emergy-money ratio. It converts the emergy term in monetary term for comparison. Unit : Emdollar(Em$), Emwon(EmW), etc, depending on the currency.</td>
</tr>
<tr>
<td>Emergy use per capita</td>
<td>It represents the standard of living of a system, and obtained by dividing the total emergy use of a system by the number of people. Unit : sej/ capita</td>
</tr>
<tr>
<td>Emergy yield ratio (EYR)</td>
<td>EYR is calculated by dividing total emergy of products by purchased emergy from outside the system. The higher EYR, the more competitive of an economy or process.</td>
</tr>
</tbody>
</table>
Examples of emergy indices

<table>
<thead>
<tr>
<th>Emergy indices</th>
<th>Definitions (Odum, 1996)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Population carrying capacity</td>
<td>The number of people that could be supported by the environment and economy. Renewable carrying capacity is obtained by multiplying the fraction of renewable emergy in the total emergy use of a system by the number of people. Developed carrying capacity is the number of people that could be supported by the environment and economy of a system if the system develops at the level of developed countries.</td>
</tr>
<tr>
<td>Emergy use per unit area</td>
<td>Total emergy use by an economic system divided by area of the system. It indicates the spatial concentration of economic activities. Unit : sej/m²</td>
</tr>
<tr>
<td>Environmental loading ratio (ELR)</td>
<td>It represents the degree of environmental stress caused by socioeconomic activities. ELR is calculated by dividing the sum of outside emergy and internal nonrenewable emergy by internal environmental emergy. Low ELR means that socioeconomic activities have less impact on the environment.</td>
</tr>
<tr>
<td>Emergy sustainability index (ESI)</td>
<td>ESI is obtained by dividing emergy yield ratio by environmental loading ratio. The smaller ESI, the higher the dependency of a system on nonrenewable resources and outside sources, and the higher the stress of socioeconomic activities on environment.</td>
</tr>
</tbody>
</table>

II. Overview of MAPS-SEV

1. Structure
2. Tools Needed
3. Procedure
4. Participants
II-1. Structure

Structure of MAPS-SEV

- Emergy valuation using Spatial information on the natural capital (NC) and ecosystem services (ES) of marine and coastal ecosystems for helping decision making in the Marine spatial planning
  - Emergy valuation to quantify the value of NC and ES
  - Spatial mapping to visualise the value of NC and ES

II-2. Tools Needed

Tools needed to implement MAPS-SEV

- GIS program
  - ArcGIS used for a demonstration site
- MS Excel program
  - Raw data management for the calculation and mapping of the value of natural capital and ecosystem services of marine and coastal systems
Spatial emery mapping procedure

**Raw Data Map**
- Environmental Inputs: Annual inputs (sun, tide, river, etc)
- Stored Resources: Stock (biomass, sand reserve, etc)
- Ecosystem Services: Annual production (fishery, mining, etc)
- Purchased Inputs: Purchased inputs (fuel, equipments, labor, etc)

**Energy, Mass, Money Map**
- Annual inputs (J/yr, g/yr, $/yr, etc)
- Stock ($, g, $/yr, etc)
- Annual production (J/yr, g/yr, $/yr, etc)

**Emergy Map**
- Emergy Flow (sej/yr)
- Emergy Storage (sej)
- Emergy Flow (sej/yr)

**Emvalue Map**
- Environmental Flow Value Map
- Stored Resource Value Map
- Ecosystem Services Value Map
- Purchased Input Value Map

**Emergy (sej/yr)** = Raw data $\times$ Unit emery value (sej/J, sej/g, sej/$, etc)

**Emvalue (em$/yr)** = Emergy (sej/yr) / Emergy-money ratio (sej/$)

- Emergy-money ratio for Korea in 2011 = $5.36 \times 10^{12}$ sej/$

**MAPS-SEV**

II-3. Procedure

**Overview of the MAPS-SEV procedure**

- **Boundary Delineation**
  - Define the boundary of a system under consideration that reflects the purpose of the valuation
  - Determine appropriate spatial resolution

- **Issue Identification**
  - What are the important problems in the area that require MAPS-SEV application?

- **Data Collection**
  - Collect appropriate data and information for natural capital and ecosystem services that will be valued?

- **Map Preparation**
  - Prepare base maps and convert collected spatial data into GIS files

- **Spatial Emergy Mapping**
  - Construct emery maps for individual natural capital and services
Who should be involved in the MAPS-SEV process?
- Preliminary analysis: 5 experts in marine policy, valuation, GIS, and marine sciences
- Main process: 7 participants including stakeholders

III. Valuation Boundary Delineation
Where is your area of concern?
- Demonstration site: Gyeonggi Bay in the mid-western coast of ROK
- Chosen as a demonstration site for MAPS-SEV due to
  - multiple uses and conservation needs exist
  - heavy development pressure and resultant marine ecosystem deterioration accumulating over the last decades

Geographic features
- Coastline length: 526 km
- No. of islands: 130
- Average depth: ca. 20 m
- Coastal population
  - 3.2 million people
  - density: 956 people/km²

Map source: Google Maps
(www.googlemap.com)

How big is the Gyeonggi Bay?

Map source: Google Maps
(maps.google.com)
Where to draw the boundary for the area of concern?
- Criteria for boundary delineation
  - Environmental features, socioeconomic activities, available data and information, etc
- Demonstration site
  - Environmental features: spatial range of freshwater influence
  - Socioeconomic characters: intensity of socioeconomic activities
  - Information: availability of reliable data and information

Spatial resolution of the mapping
- 1/20° (ca. 5 km, 24.5 km²) for the Gyeonggi Bay case
  - that reflects the spatial resolution of marine ecosystem data collected in the regular national surveys
  - for efficient handling of data in the WGS84 datum
IV. Issue Identification

What are the main issues in the area?
- What are the uses or socioeconomic activities in the area?
- Who are the stakeholders involved in the issues?

- Urban sprawl
- Industrial complexes
- Port expansion
- Overfishing
- Marine mining
- MPA management
- Energy development
- Endangered species management
- Lack of effective management mechanisms
- Weak informed decision making

- Coastal inhabitants
- Fishermen
- Port authority
- Industry
- NGOs
- Local governments
- National government

Map source: Google Maps (www.googlemap.com)
V. Data Collection

Types of data for emergency calculation:
- Environmental sources: sun, wind, wave, rain, tide, river input, currents, etc.
- Natural capital: fishery resources, mineral and energy resources, etc.
- Ecosystem services (annual data): food production, mineral & energy production,

Data sources: preferable to have site specific data:
- Area specific scientific data and statistics
- Estimation based on national scientific data and statistics, or
- International database: FAO, IEA, UNEP, CBD, World Bank, NOAA, USGS, etc.
### V-1. Data Collection

Data and information collected for the Gyeonggi Bay demonstration site. For natural capital and ecosystem services, items that have reliable data and information were only presented as a preliminary spatial mapping.

<table>
<thead>
<tr>
<th>Category</th>
<th>Items</th>
<th>Unit</th>
<th>Reference</th>
</tr>
</thead>
<tbody>
<tr>
<td>Environmental inputs</td>
<td>Sunlight</td>
<td>Insolation, J/m²/yr</td>
<td>KMA</td>
</tr>
<tr>
<td></td>
<td>Wind</td>
<td>Average wind speed, m/sec</td>
<td>KMA</td>
</tr>
<tr>
<td></td>
<td>Rainfall</td>
<td>Annual rainfall, m</td>
<td>KMA</td>
</tr>
<tr>
<td></td>
<td>Wave</td>
<td>Wave energy density, kW/m</td>
<td>KIOST</td>
</tr>
<tr>
<td></td>
<td>Tide</td>
<td>Average tidal range, m</td>
<td>KOHA</td>
</tr>
<tr>
<td></td>
<td>River input</td>
<td>River discharge, m³/yr</td>
<td>MLTM</td>
</tr>
<tr>
<td>Natural capital</td>
<td>Benthos</td>
<td>Biomass, g/m²</td>
<td>KOEM</td>
</tr>
<tr>
<td>Ecosystem services</td>
<td>Fishery production</td>
<td>Production, kg/yr</td>
<td>Yearbook</td>
</tr>
<tr>
<td></td>
<td>Marine sand extraction</td>
<td>Extraction volume, m³/yr</td>
<td>Yearbook</td>
</tr>
</tbody>
</table>

- KMA = Korea Meteorological Administration
- KIOST = Korea Institute of Ocean Science and Technology
- MLTM = Ministry of Land, Infrastructure and Transport
- KOEM = Korea Marine Environment Management Corporation
- Yearbook = Statistical Yearbook of Korea and local governments

### VI. Map Preparation

1. Process Overview
2. Base Map Preparation
3. Raw Data File Preparation
4. Spatial Interpolation
5. Spatial Grid Construction
VI-1. Process Overview

Flow diagram for map preparation of MAPS-SEV

- Base Map Preparation
  - Map acquisition
  - Coordinate extraction
  - GIS shape file creation
  - Coordinate system selection
  - Polygon creation

- Raw Data File Preparation
  - Coordinate format
  - Excel data to GIS files

- Spatial Interpolation
  - Estimation of unknown values
    - IDW interpolation
    - Thiessen polygon interpolation

- Spatial Grid Data Map
  - Grid polygon creation
  - Raster datasets to point features
  - Point layers to grid layers

- Data collection
  - Digital nautical charts
  - World countries map from internet, or
  - Paper maps or Satellite Images
  - Environmental inputs
  - Natural capital
  - Ecosystem services

VI-2. Base Map Preparation

Maps required for the base map preparation

- Digital nautical charts (WGS 1984 ellipsoid) in DXF format produced by KHOA for the Gyeonggi Bay case
VI-2. Base Map Preparation

MAPS-SEV

Extract coastline from polyline feature in the DXF file
- ArcGIS command: Query Builder for natural and artificial coastlines

VI-2. Base Map Preparation

MAPS-SEV

Save the extracted coastline in a GIS shape file
- ArcGIS command: Data ▸ Export Data
Select a coordinate system

ArcGIS command: ArcToolbox ➤ Projections and Transformations ➤ Raster ➤
Define Projection

WGS1984_UTM_Zone52N for the Gyeonggi Bay case

- WGS1984: Ellipsoid
- UTM: Coordinate system
- Zone52N: UTM zone number for ROK

UTM grid zones
VI-2. Base Map Preparation

MAPS-SEV

- Close the coastline polyline and convert it to polygon
  - ArcGIS command: ArcToolbox > Data Management Tools > Features > Feature to Polygon

MAPS-SEV

- Alternative 1 based on downloadable maps from ESRI:
  - When digital nautical charts are not available, data and maps can be downloaded from ESRI (Data and Maps for ArcGIS)

VI-2. Base Map Preparation

Alternative 1 based on downloadable maps from ESRI

Data and Maps for ArcGIS: World Countries

MAPS-SEV

VI-2. Base Map Preparation

Alternative 2 based on Paper maps or satellite images
- Digitise coastline with the ArcGIS command Create Feature
  - For ArcGIS, world imageries are provided online
  - High resolution maps are required
  - Important to match ellipsoid and coordinate system

Map source: Google Maps
(www.googlemap.com)

VI-3. Raw Data File Preparation

- Convert coordinate formats
  - Different coordinate formats of various types of raw data need to be converted to a single uniform format
  - Decimal degree format for the Gyeonggi Bay case

### DMS format

<table>
<thead>
<tr>
<th>Longitude</th>
<th>Latitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>125</td>
<td>00</td>
</tr>
<tr>
<td>126</td>
<td>00</td>
</tr>
<tr>
<td>127</td>
<td>00</td>
</tr>
</tbody>
</table>

### DM format

<table>
<thead>
<tr>
<th>Longitude</th>
<th>Latitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>126.41</td>
<td>36.30</td>
</tr>
<tr>
<td>126.35</td>
<td>36.30</td>
</tr>
<tr>
<td>126.22</td>
<td>36.30</td>
</tr>
</tbody>
</table>

### Decimal degree format

<table>
<thead>
<tr>
<th>Longitude</th>
<th>Latitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>126.64</td>
<td>36.47565</td>
</tr>
<tr>
<td>128.91</td>
<td>35.59667</td>
</tr>
<tr>
<td>126.16</td>
<td>39.37166</td>
</tr>
</tbody>
</table>

Conversion formula:

- DMS to DM: \[ M = M + S/60 \]
- DMS to Decimal degree: \[ D = D + M/60 \]
VI-3. Raw Data File Preparation

- Convert excel data into ArcGIS point files
- Various data stored in MS Excel files with coordinate information
- ArcGIS command: `Create Feature Class from XY Table`

![Data in Excel spreadsheet](image1.png)

Example data:

<table>
<thead>
<tr>
<th>Id.</th>
<th>Long.</th>
<th>Lat.</th>
<th>Dimension</th>
</tr>
</thead>
<tbody>
<tr>
<td>01</td>
<td>126.8031111</td>
<td>36.46031667</td>
<td>34.954</td>
</tr>
<tr>
<td>02</td>
<td>126.7898278</td>
<td>36.93555556</td>
<td>133.714</td>
</tr>
<tr>
<td>03</td>
<td>126.8038296</td>
<td>36.80627778</td>
<td>63.612</td>
</tr>
<tr>
<td>04</td>
<td>126.8376833</td>
<td>36.80985333</td>
<td>77.687</td>
</tr>
<tr>
<td>05</td>
<td>126.8165566</td>
<td>36.92938589</td>
<td>153.53</td>
</tr>
<tr>
<td>06</td>
<td>126.8047027</td>
<td>36.91922224</td>
<td>4.284</td>
</tr>
<tr>
<td>07</td>
<td>126.8436056</td>
<td>36.64166667</td>
<td>315.08</td>
</tr>
<tr>
<td>08</td>
<td>126.8725055</td>
<td>36.89948444</td>
<td>256.634</td>
</tr>
<tr>
<td>09</td>
<td>126.8034444</td>
<td>36.89575</td>
<td>192.448</td>
</tr>
<tr>
<td>10</td>
<td>126.5774444</td>
<td>31.02451111</td>
<td>20.888</td>
</tr>
<tr>
<td>11</td>
<td>126.4727778</td>
<td>31.02506667</td>
<td>54.555</td>
</tr>
<tr>
<td>12</td>
<td>126.4690322</td>
<td>31.00000000</td>
<td>33.599</td>
</tr>
<tr>
<td>13</td>
<td>126.4629944</td>
<td>31.02111111</td>
<td>0.00</td>
</tr>
<tr>
<td>14</td>
<td>126.42129889</td>
<td>31.05000000</td>
<td>2.08</td>
</tr>
<tr>
<td>15</td>
<td>126.45345278</td>
<td>31.05432222</td>
<td>400.712</td>
</tr>
<tr>
<td>16</td>
<td>126.449975</td>
<td>37.95075</td>
<td>393.266</td>
</tr>
<tr>
<td>17</td>
<td>126.45515778</td>
<td>8.04199999</td>
<td>0.875</td>
</tr>
</tbody>
</table>

Point.shp

VI-4. Spatial Interpolation

- Spatial interpolation is performed to estimate unknown values for parameters in the target area from a limited number of data points
- Two interpolation methods used for the Gyeonggi Bay case
  - Thiessen polygon interpolation for parameters with irregularly spaced points
  - Inverse Distance Weighted (IDW) interpolation for parameters with more regularly spaced data points
- Thiessen polygon interpolation
  - Polygons are generated from irregularly spaced data points.
  - Each Thiessen polygon defines an area of influence around its sample point, so that any location inside the polygon is closer to that point than any of the other sample points.
Inverse Distance Weighted (IDW) Interpolation

- A deterministic method for multivariate interpolation with a scattered set of points with measured values.
- Values for any unmeasured location are predicted as weighted averages of measured values surrounding the prediction location.
- Greater weights to points that are closer to the prediction location, with weights decreasing as a function of distance.

\[
Z_p = \frac{\sum_{i=1}^{n} Z_i W_i}{\sum_{i=1}^{n} W_i}
\]

- \(Z_p\) = Predicted value
- \(Z_i\) = Measured value for location \(i\)
- \(W_i\) = Weighting factor
- \(n\) = Number of measured values

Weighting factors as an inverse function of distance from surrounding points with measured values.

ArcGIS command: Spatial Analyst Tools > Interpolation > IDW

- Output cell size
- Weighting factor
- Processing extent
VI-4. Spatial Interpolation

- **Inverse Distance Weighted (IDW) Interpolation**
  - An example from the Gyeonggi Bay case

Chlorophyll-a concentration in the Gyeonggi Bay

---

**Thiessen polygon interpolation**

For the Gyeonggi Bay case, Thiessen polygons were created for macrozoobenthic biomass because the data did not show the characteristics of spatially continuous distribution.

ArcGIS command: **Analysis Tools ➔ Proximity ➔ Create Thiessen Polygon**
VI-4. Spatial Interpolation

- Thiessen polygon interpolation
  - An example for the Gyeonggi Bay case

Thiessen polygons generated for macrozoobenthic biomass in the Gyeonggi Bay

VI-5. Spatial Grid Data Map Construction

- Spatial boundary for the Gyeonggi Bay case

<table>
<thead>
<tr>
<th>Station</th>
<th>Latitude</th>
<th>Longitude</th>
</tr>
</thead>
<tbody>
<tr>
<td>St.1</td>
<td>37.8°</td>
<td>126.05°</td>
</tr>
<tr>
<td>St.2</td>
<td>37.8°</td>
<td>126.80°</td>
</tr>
<tr>
<td>St.3</td>
<td>37.0°</td>
<td>126.05°</td>
</tr>
<tr>
<td>St.4</td>
<td>37.0°</td>
<td>126.80°</td>
</tr>
</tbody>
</table>
VI-5. Spatial Grid Data Map Construction

Create polyline by connecting the four boundary stations:
- 1/20° interval (~5 km) for the Gyeonggi Bay case.
- ArcGIS command: **Editor > Create Features > Copy parallel**

Close the polyline and then create grid polygons:
- ArcGIS command: **Feature to polygon**
- Gyeonggi Bay case:
  - 180 grids with a total area of 3,750 km²
  - A grid with an interval of 1/20° (~5 km) with an area of about 24.5 km²
VI-5. Spatial Grid Data Map Construction

- Calculate area of grids
  - First remove land from the grid polygons
    - ArcGIS command: Analysis Tools ➤ Overlay ➤ Erase

![Image of ArcGIS analysis tools]

- Calculate area of grids
  - ArcGIS command: Table ➤ Calculate Geometry

![Image of ArcGIS calculate geometry tool]

---

- 76 -
VI-5. Spatial Grid Data Map Construction

- Conversion of raster datasets to point features
  - Conversion of raster data from IDW interpolation to point data for Spatial join
    - Raster data not applicable for spatial join
  - ArcGIS command: Conversion Tools ➔ From Raster ➔ Raster to Point

- An example of conversion of raster data from IDW interpolation to point data

Chlorophyll-a in the Gyeonggi Bay
MAPS-SEV

VI-5. Spatial Grid Data Map Construction

- Convert point layers to grid layers: IDW interpolated data
- Spatial Join is performed to combine point data in a grid
- ArcGIS command: Analysis Tools > Overlay > Spatial Join

Select merge rule:
- First, Last, Count, Minimum, Maximum, Sum, Mean, Standard Deviation, Median, Mode, Range

An example for the Gyeonggi Bay case
VI-5. Spatial Grid Data Map Construction

- Convert point layers to grid layers: IDW interpolated data
- Process summary
  - Raw Data Point
  - Raster (IDW)
  - Grid
  - Point

- Convert point layers to grid layers: Thiessen polygons
- Convert Thiessen polygons to grid layer
- Grid area calculation
  - ArcGIS command: Table > Calculate Geometry
- Weighting factors are used to calculate mean value of a grid for data from different polygons
  - Weighting factor based on the fraction of area in a grid
VI-5. Spatial Grid Data Map Construction

Convert point layers to grid layers: Thiessen polygons
- An example for the Gyeonggi Bay case
VII. Spatial Emergy Mapping

1. Intermediate Data Calculation
2. Emergy Calculation
3. Emvalue Calculation
4. Emergy Maps

MAPS-SEV

VII-1. Intermediate Data Calculation

- Raw data to intermediate data, if needed
- ArcGIS command: Field Calculator
- Example: Energy calculation from macrofauna biomass for the Gyeonggi Bay case
MAPS-SEV

VII-2. Emergy Calculation

- Emergy calculation from maps for raw or intermediate data
  - ArcGIS command: Field Calculator
  - Example: Emergy calculation from macrofauna energy data for the Gyeonggi Bay case

MAPS-SEV

VII-3. Emvalue Calculation

- Emvalue calculation from emergy maps
  - ArcGIS command: Field Calculator
  - Example: Emvalue calculation from macrofauna emergy data for the Gyeonggi Bay case
MAPS-SEV

VII-4. Emergy Maps

Environmental inputs: Rain, chemical potential energy

Raw data map

Energy map

Emergy map

Emvalue map

MAPS-SEV

VII-4. Emergy Maps

Environmental inputs: Wave

Raw data map

Energy map

Emergy map

Emvalue map
MAPS-SEV

VII-4. Emergy Maps

- Environmental inputs: Tide

- Raw data map

- Energy map

- Emergy map

- Emvalue map

- Environmental inputs: River, chemical potential energy

- Emergy map

- Emvalue map
MAPS-SEV

VII-4. Emergy Maps

- Total renewable emergy input to the Gyeonggi Bay
- Tide emergy + River inflow emergy

MAPS-SEV

- Total emvalue of renewable emergy input to the Gyeonggi Bay
- Tide emvalue + River inflow emvalue
MAPS-SEV

VII-4. Emergy Maps

Ecosystem services: Marine sand extraction

Raw data map

Emergy map

Emvalue map

VIII. Application of MAPS-SEV
What are the potential uses of ecosystem value maps produced by MAPS-SEV?

- Spatial decision making on the selection of priority areas for conservation and management alternatives
- Trade-off analysis among different ecosystem services, especially conflicting uses among different stakeholders
- Reference data for potential compensation and environmental taxes on marine and coastal activities
- Integration of the value of natural capital and ecosystem services into environmental impact assessment
- Cost-benefit analysis of development proposals and restoration projects
- Awareness raising and education on the importance of marine and coastal ecosystems
Course 3: 
Marine InVEST 
(Integrated valuation of environmental services and tradeoffs)
Natural Capital: concepts, methods and initiatives

Outline

• Introduction to concepts
• Evolution of natural capital thinking globally
• Diversity of assessment methods and tools
**capital** is the stock of assets that can be used to produce goods and services that provide benefits to consumers

**natural capital** is the stock of assets provided by natural systems that can be used—together with other assets—to produce ecosystem goods and services that deliver benefits to consumers

**ecosystem services** are the benefits that flow from natural capital
Food, fuel, fiber
Pollination
Climate regulation
Coastal protection
Clean water
Spiritual Fulfilment

- 95 -
Spatially-Explicit Ecological Production Functions

**Ecological Production Function** - an equation that relates the physical outputs of a production process to physical inputs

---

Links between biodiversity and...

- …ecosystem functions
  - Biomass production
  - Decomposition
  - Nutrient recycling
- …ecosystem services
  - Positive: crop yields, fisheries, timber yields, carbon sequestration
  - Negative/equivocal: water purification, disease regulation

Cardinale et al. 2013 *Nature*
Timeline

2005
- Ecosystem Services Partnership
- US National Ecosystem Services Partnership
- A Conference on Ecosystem Services (ACES)
- The Economics of Ecosystem and Biodiversity (TEEB)
- Wealth Accounting and Valuation of Ecosystem Services (WAVES)
- ProEcoServ

2008 – 2010
- The B Team
- Natural Capital Business Hub
- Natural Capital Leaders Index
- World Forum on Natural Capital

2012
- Natural Capital Coalition
- GLOBE Natural Capital Initiative
- Natural Capital Declaration
- Natural Capital Leadership Compact
- UK Natural Capital Committee

2013

Uptake of natural capital approaches

- Corporate policy and governance
- Corporate strategy
- Decision-making approaches and tools
- IFC
- SRIs
- Adopters of Equator Principles

Public sector exploration:
- Canada
- Ecuador
- China
- Spain
- Colombia
- Vietnam
- Costa Rica
- United States

NGO activity
- Agreement on overarching definitions
- Strong basic science

Business for Social Responsibility, 2012
Ecosystem Service Assessment Tools

ARIES (ARtificial Intelligence for Ecosystem Services)

InVEST (Integrated Valuation of Ecosystem Services and Tradeoffs)

ESValue

EcoMetrix

A common vision to create a world where business conserves and enhances natural capital
InVEST

Supply
Potential available

Service
Delivered to people

Value
Economic & social impacts

Quantify, map and value the benefits provided by terrestrial, freshwater and marine systems

Free. Open source.
http://www.naturalcapitalproject.org
Production Functions and Ecosystem Services

Alternative management, policy → Δ Ecosystem structure → Δ Ecosystem function → Δ Ecosystem service → Δ Ecosystem service value

Habitat restoration decision → Streamside habitat area → Water filtration & retention → Sediment load in stream agricultural yield → Avoided treatment cost Crop revenues People affected

Change in environment → Change in benefits (production function)

InVEST Models
Scenarios

Plausible, simplified, descriptions of the future

• Useful for examining how actions taken today play out into the future
• InVEST requires scenarios of maps of land/ocean cover

Vancouver Island

Future?

Guerry et al. 2012
Terrestrial / FW Models

- Biodiversity: Habitat Quality
- Water yield for hydropower production
- Erosion control: reservoirs and WQ
- Water purification: nutrient retention
- Carbon sequestration & storage
- Managed timber production
- Crop pollination

Coastal & Marine Models

- Recreation*
- Aquaculture
- Fisheries*
- Coastal Protection*
- Renewable Energy  (wave and wind)
- Scenic Quality
- Water Quality
- Habitat Risk Assessment*
- Carbon Sequestration
Data Input Examples

**Spatial data**

<table>
<thead>
<tr>
<th>Land use/Land cover</th>
<th>Soil type</th>
<th>Topography</th>
<th>Cities</th>
<th>Infrastructure</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Example" /></td>
<td><img src="image2.png" alt="Example" /></td>
<td><img src="image3.png" alt="Example" /></td>
<td><img src="image4.png" alt="Example" /></td>
<td><img src="image5.png" alt="Example" /></td>
</tr>
</tbody>
</table>

**Associated data**

Examples:
- Carbon pools by land use/land cover and soil
- Habitat suitability by land use/land cover
- Market value of timber or carbon

---

**Economic valuation methods**

- Market valuation
  - Carbon
  - Timber
  - Non-timber forest products
- Avoided damage costs
  - Water purification
  - Flood mitigation
  - Avoided reservoir sedimentation
- Production Economics
  - Water for irrigation
  - Pollination of agricultural crops
Recreation & Tourism: example

Recreation is:

• A service provided by nature
• Important for health and well-being of people
• Important to local economies

Recreation

Supply
Potential available

Service
Delivered to people

Value
Economic & social impacts

Coral reefs
visitation rate = predictor + predictor + predictor + 

correlation coefficient: 0.26 - 0.78
proxy data

flickr photos

n = 200 million

invest model

visitation rate = f (habitats and infrastructure)
Recreation example: Output

- Where are people visiting?
- What factors are positively or negatively correlated with visitation?
- What is the value provided by tourism?
- How might visitation and expenditures differ in the future?

InVEST Models & Linkages

Belize

Terrestrial/freshwater model: Tier 0
Terrestrial/freshwater model: Tier 0
Marine model: Tier 1
Marine model: Tier 0
Model coming soon!

Optional model linkage
Required model linkage
Why InVEST?

• Applicable anywhere on the globe
• With minimal data
• Flexible scale
• Scenario based
• Relevant to many kinds of decisions
• Biophysical and economic
• Multi-services comparisons (synergies and tradeoffs)
Preparing & Visualizing Data

www.arcgis.com
License required

www.qgis.org
Free

InVEST 2.x + ArcGIS dependency → phased out by 2015

InVEST 3.0
- faster/more stable models
- independent from costly ArcGIS software
- improved user interface
- enhanced documentation and user support

InVEST integrated valuation of environmental services and tradeoffs
Marine Spatial Planning using InVEST Models

The Natural Capital Project
Incorporating nature’s benefits into decisions

Spatial Planning
Payment for Ecosystem Services
Climate Adaptation Planning
Development Impacts and Permitting
Restoration Planning
Corporate Risk Management
1. Integrated coastal zone management plan in Belize

Facilitate the balanced and sustainable use of the coastal and marine environment for the benefit of Belizeans and the global community.

Coastal and marine ecosystems provide important benefits to the Belizean people.
Define Partnerships, Roles & Objectives

1. Compile Data
2. Generate Baseline & Scenarios
3. Iterate & Build Capacity
4. Assess Outcomes
5. Synthesize Results
6. Inform Decisions
7. Inform Decisions

Stakeholder engagement

InSEAM

InVEST
Integrated Valuation of Ecosystem Services & Tradeoffs

COASTAL PLANNING REGIONS

Northern Belize
Central Belize
Southern Belize

Models
Possible future scenarios (2025)

Based on current distribution of uses, other planning efforts, stakeholder visions
Informed first ICZM Plan in Belize
- Vote in the House of Representatives

Trained professionals in InVEST Software
- Contributed their perspectives on zoning options
- The CMAI expects to continue using InVEST in future environmental impact assessments for the coastal zone

Summary

- Applying a BES approach is most effective in leading to policy changes
- Simple ecological production function models have been useful in a diverse set of decision contexts
- Training local experts in the approaches and tools is important for building local capacity, ownership, trust, and long-term success
- Decision makers and stakeholders prefer to use a variety of BES value metrics
- An important science gap exists in linking changes in BES to changes in livelihoods, health, cultural values, and other metrics of human wellbeing
- Communicating uncertainty in useful and transparent ways remain challenging

Ecological Economics (Ruckelshaus et al. 2013)
Ecosystem Service Model Applications for Decision Making

1. Jeju Island, Korea: Sustainable development

Main Issue of Natural Capital Management in Jeju

- Conservation Efforts vs. Development Pressure

<table>
<thead>
<tr>
<th>Year</th>
<th>Area(he)</th>
<th>Agri. L</th>
<th>Barren L</th>
<th>Urban L</th>
<th>Forest L</th>
<th>Grassland</th>
<th>Water</th>
<th>Wetland</th>
</tr>
</thead>
<tbody>
<tr>
<td>1989</td>
<td></td>
<td>379.32</td>
<td>7.83</td>
<td>69.39</td>
<td>924.93</td>
<td>466.55</td>
<td>37.12</td>
<td>0.59</td>
</tr>
<tr>
<td>1998</td>
<td></td>
<td>394.12</td>
<td>15.10</td>
<td>88.86</td>
<td>1035.46</td>
<td>322.08</td>
<td>29.16</td>
<td>0.39</td>
</tr>
<tr>
<td>2009</td>
<td></td>
<td>819.76</td>
<td>15.34</td>
<td>98.89</td>
<td>649.29</td>
<td>271.38</td>
<td>30.50</td>
<td>0.38</td>
</tr>
<tr>
<td></td>
<td>Increase &amp; Decrease</td>
<td>+116</td>
<td>+96</td>
<td>+43</td>
<td>-30</td>
<td>-42</td>
<td>-18</td>
<td>-36</td>
</tr>
</tbody>
</table>

Water
Urban Land
Barren Land
Wetland
Grassland
Forest Land
Agricultural Land
Objectives for the Jeju Applications

- **Background**

<table>
<thead>
<tr>
<th>PRESSURE</th>
<th>STATUS</th>
<th>IMPACT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Changes in Pressures</td>
<td>Change of Ecosystem Structure</td>
<td>Changes in provision of Ecosystem Service</td>
</tr>
</tbody>
</table>

- Urban and Agricultural Land ↑
- Release of Protected Areas
- International Free City
- Development in Middle Mountainous Area

- **Main Objectives**

1. Apply integrated ES modeling approaches to JeJu Island
2. Explore changes in ES in response to changes in LULC by time
3. Explore changes in ES under alternative scenarios
4. Use this information to inform decisions for SD for Jeju

Evaluation System of Ecosystem Service in Jeju

- Regulating Service
  - Carbon Seq. (tonC, W)

- Cultural Service
  - Eco-tour (# of visitor, W)
  - Big Data - Geo-tagged photos, Mobile phone, Credit card

- Supporting Service
  - Management
  - Sensitivity
  - Pressure

Land Cover

Local Government → Scenario → Local Resident
Evaluation of Habitat Quality in Jeju

● Input Data: Threat Factors (Factor, Weighting, Maximum Impact Distance, Impact Trend)

- Road, 0.59, 2.4km, Linear
- Urban L., 0.88, 5.9km, Exponential
- Agri. L., 0.57, 3.4km, Linear
- Fragment, 0.43, 1.5km, Exponential
- Disaster, 0.40, 1.2km, Linear
- Treat. Facility, 0.50, 5.0km, Linear

※ Reference to Natural Capital Project, Terrado et al. (2015, Model development for the assessment of terrestrial and aquatic habitat quality in conservation planning)

Evaluation of Habitat Quality in Jeju

● Input Data: Accessibility

- 12 Protected Areas + Non-Protected Area

1. Wetland Protected Area I 0.10
2. Specific Conservation Island V 0.50
3. Nature Park (Nature Conservation) I 0.10
4. Nature Park (Nature Environment) II 0.20
5. Natural Reserve Area III 0.30
6. Absolute Preservation Area III 0.30
7. Ecosystem Conservation Area I 0.10
8. River District I 0.10
9. Water Source Protection Area I 0.10
10. Green Area (Conservation) IV 0.40
11. Green Area (Nature) VI 0.60
12. Reserve Forest (Public) IV 0.40
13. Non-Protected Area VII 1.00

Utility Strength (Prohibition, Limit, Permission) based on Related Law
Evaluation of Habitat Quality in Jeju

- **Result:** Evaluation

<table>
<thead>
<tr>
<th>Year</th>
<th>1989</th>
<th>1998</th>
<th>2009</th>
</tr>
</thead>
<tbody>
<tr>
<td>Value</td>
<td>0.60 ± 0.27</td>
<td>0.62 ± 0.28</td>
<td>0.50 ± 0.28</td>
</tr>
<tr>
<td>Quality</td>
<td>High</td>
<td>High</td>
<td>Low</td>
</tr>
</tbody>
</table>

- **Result:** ΔHabitat Quality (2009-1989)

- Changes in Habitat Quality: High → Low

- **Graph:** Change in habitat quality over 20 years.
Assessment of carbon sequestration capacity in Jeju

- Conceptual model of carbon storage and sequestration

Input data 1 : Carbon pool table
Input data 2 : Land cover map

Carbon pool composition
1. Aboveground biomass
2. Belowground biomass
3. Soil carbon
4. Dead wood
5. Harvested wood products

Input data 1:

<table>
<thead>
<tr>
<th>code</th>
<th>LUCC_name</th>
<th>C_above</th>
<th>C_below</th>
<th>C_soil</th>
<th>C_dead</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Forest</td>
<td>1.00</td>
<td>0.00</td>
<td>0.00</td>
<td>0.00</td>
</tr>
<tr>
<td>2</td>
<td>Coffee</td>
<td>0.00</td>
<td>0.40</td>
<td>0.25</td>
<td>0.00</td>
</tr>
<tr>
<td>3</td>
<td>Pasture/field</td>
<td>1.20</td>
<td>0.20</td>
<td>0.30</td>
<td>0.00</td>
</tr>
<tr>
<td>4</td>
<td>Grassland</td>
<td>0.30</td>
<td>0.30</td>
<td>0.20</td>
<td>0.13</td>
</tr>
<tr>
<td>5</td>
<td>Open/urban</td>
<td>0.05</td>
<td>0.15</td>
<td>0.00</td>
<td>0.00</td>
</tr>
</tbody>
</table>

Assessment of carbon sequestration capacity in Jeju

- Results

Carbon sequestration values (Discount rate: 5%)

- 1989: 29,268 Gg
- 1999: 23,968 Gg
- 2009: 21,368 Gg
Mapping and Valuing Nature-Based Recreation and Tourism in Jeju Island, Korea

• 평가방법 2. Quantitative relationships between visitation rates and attributes of the landscape

Patterns of visitation based on Big Data

Flickr Photo user-days  Twitter user-days  Mobile Phone Users

Drivers of Visitation

Accessibility:  Natural Attractions:  Built Infrastructure:
Quantitative relationships between visitation rates and attributes of the landscape

Visitation = f

Spatial variation of visitors can be explained by accessibility, natural and build attractions (R² = 0.56)

Positive Relationship:
- Commercial Zones
- Cultural/Historic places
- Natural monuments
- Roads
- Sandy Beaches
- Waterfalls
- Scenic viewpoints
- Distance from ports
- Land area
- Forest
- Golf Course
- industrial Area
- Orle Trail
- Distance from loads

Negative Relationship:
- No. Sig. Relationship

Mapping and Valuing Nature-Based Recreation and Tourism in Jeju Island, Korea
Avg. Expenses for Tourism: $43.00/Credit Card Use

Mapping and Valuing Nature-Based Recreation and Tourism in Jeju Island, Korea

3. Credit Card Expenditure

Lodging Avg. Expenditure: $46.00
Food Avg. Expenditure: $40.00
Travel Avg. Expenditure: $42.00
Activities Avg. Expenditure: $76.00
The places people visit reveal their preferences about natural environments.

Quantitative relationships between visitation rates and attributes of the landscape show which attributes are most valued by tourists.

These relationships can be applied to future scenarios of development or conservation to understand how tourism patterns may change.
Scenarios:
Land cover change in Jeju (2025)

Future
2025 estimated value

Based on

- Jeju Metropolitan City Plan 2025
- Logistic regression analysis based on historic trends

Use of Ecosystem Service Framework to Inform Decisions

- UN Post-2015 Agenda
- SDGs
- International Agenda

- Domestic Implementation
- Official Plan
- Implementation
- Government Implementation

- KEI Technique
- Ecosystem Service Modeling
- Sustainability Index
- Cooperation of Science and Technology

- Application/Assessment
- Jeju, Other Islands, Etc.

- DB
- Construction of DB
Appendix 1:
Integrated Coastal Management of RO KOREA
Integrated Coastal Management of RO Korea

Our coasts provide not only important habitats for marine life, but also the basis of livelihood for human wellbeing.
The west and the south coast, which consist of small and large bays, small peninsulas, and countless islands, have more than 90% of Korea’s ecologically invaluable coastal wetland, serving as a habitat for marine life. The east coast has beautiful beaches, sand bars, and lagoons scattered along the coastline.

Suncheon Bay (Ramsar site), one of Wetland Protected Area, is of great ecological value as a winter habitat for an internationally renowned rare species.

Sinduri Sand dune

Spotted seals, Baengnyeong Island

Haegeumgang Island

The Evolutionary Process of Integrated Coastal Management in RO Korea

As Chapter 17 of Agenda 21 had recommended ‘Integrated Coastal Management (ICM)’ in 1992 as a strategy to achieve the protection and sustainable use of coastal and marine resources, the Coastal Management Act that focused on ‘integration’ and ‘cooperation’ was enacted in 1999. Since it set the basic direction for national policies, the Integrated Coastal Management has produced numerous achievements, including the establishment of the National Integrated Coastal Management Plan, autonomous coastal management systems by municipalities, restriction on public water reclamation, the establishment of coastal management information systems, and raised public awareness. The government revamped the Coastal Management Act in 2008 and prepared coastal management tools, such as the Coastal Sea Area Zoning, the Coastal Sea Area Suitability Assessment, and the Target-based Natural Coast Management System.

1992
Agenda 21

1996
Ministry of Maritime Affairs and Fisheries

1999
Coastal Management Act

2000
1st National Integrated Coastal Management Plan

2000
Establishment of policies and bodies related coastal environment

2002-2008
Local Coastal Management plans

2003-2004
1st Coastal Survey

2004-
Integrated Coastal Management Information System
27% of population live in the coastal areas. There are 60 ports and 109 national fishery harbors along the coastline. RO Korea’s marine economy has developed through the continuous use and development of the coast and ocean. RO Korea is recently focusing its efforts on developing new renewable energy such as wind and solar power as well as marine energy such as tidal power in order to tackle climate change.

Haeundae is one of the most representative cities in RO Korea located in Busan. It is the most popular beach which 1 million people have visited in the summer season.

The Coastal Management Act aims to conserve the coastal environment and seeks its sustainable development, for the purpose of making the coast into a better place for livelihood. The act stipulates the scope of coastal zones, basic principles of coastal management, coastal surveys, major content and procedures of national/local integrated coastal management plans, designation and management of coastal sea area zoning & coastal erosion areas, coastal enhancement projects, and the composition and operation of the coastal management deliberation committee.
1st International Workshop on Spatial Management Tools toward Creative and Viable Coastal Societies

- 28-29 Nov. 2013, Seoul, Republic of Korea
- MOF, PEMSEA, China(SOA), Vietnam(VASI), Indonesia(Bogor Agricultural Univ.)
- Univ. of Aveiro (Portugal), Natural Capital Project, PacMARA, KOEM, KIOST, universities, etc.

1st International Training Program & 2nd Workshop on Marine Ecosystem Valuation and Spatial Management Tools

- 1-5 Sep. 2014, Seoul, Republic of Korea
- MOF, PEMSEA, Natural Capital Project, PacMARA
- China, Philippines, Cambodia, Indonesia, J apan. RO Korea
- Governmental sectors, research institutes, universities, private sectors, NGOs, etc.
- Marxan course / Marine InVEST / Emergy valuation and Marine spatial planning

Joint Workshop on Development and Application of Ocean Health Index for RO Korea and Asian Region

- 16-17 June 2015, Busan, Republic of Korea
- Prof. Benjamin S. Halpern (UCSB) and Erich J Pacheco (Conservation international)
- 40 RO Korean experts

Pilot project on the development of Ocean Health Index of RO Korea with Ocean Health Index team

Important Dates of KMI-PEMSEA Training and International Workshop 2016 (2016. 8.22 - 26, Busan, RO Korea)

- 3rd Training Program on Marine Ecosystem Services and Spatial Planning Tools
  - Call for application : May 31, 2016
  - Inquiry and submission : Heejung CHOI, chj1013@kmi.re.kr
    * The application form will be sent to potential applicants on their request.

- 4th International Workshop on Marine Ecosystem Services and Spatial Planning
  - Call for abstracts : February 28, 2016 / abstract length : 300 words or less
    * Focused theme : Challenges and perspectives in mainstreaming marine ecosystem services into marine spatial policy of coastal states
  - Acceptance Notice : March 31, 2016
  - Submission of a full paper : July 31, 2016 / paper length : 6,000 words or less
    * Full papers will be published in a special edition of international journals.
  - Inquiry and submission : Jiyeon CHOI, jychoi@kmi.re.kr

KMI will cover all costs such as round-trip airfares traveling, domestic transportation, lodges and meals, except travel insurance. A small amount of honorarium will be paid to author(s) of papers.
Appendix 2:
Contributors of the Training Program
Acknowledgments

We thank the participants in the 2nd International Training Program on Marine Ecosystem Services Valuation listed below.

★ Course contributors

<table>
<thead>
<tr>
<th>Course</th>
<th>Name</th>
<th>Organizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>MAPS-MSA</td>
<td>Jungho Nam</td>
<td>Korea Maritime Institute</td>
</tr>
<tr>
<td></td>
<td>Jongseo Yim</td>
<td>Seoul National University</td>
</tr>
<tr>
<td></td>
<td>Hee-Jung Choi</td>
<td>Korea Maritime Institute</td>
</tr>
<tr>
<td>MAPS-SEV</td>
<td>Daeseok Kang</td>
<td>Pukyong National University</td>
</tr>
<tr>
<td></td>
<td>Jungho Nam</td>
<td>Korea Maritime Institute</td>
</tr>
<tr>
<td></td>
<td>Hyun-Woo Choi</td>
<td>Korea Institute of Ocean Science and Technology</td>
</tr>
<tr>
<td></td>
<td>Kyuhee Son</td>
<td>Korea Marine Environment Management Corporation</td>
</tr>
<tr>
<td>Marine InVEST</td>
<td>Choong-Ki Kim</td>
<td>Korea Environment Institute</td>
</tr>
<tr>
<td></td>
<td>Gregg Verutes</td>
<td>Natural Capital Project</td>
</tr>
</tbody>
</table>

★ The Training Program Organizers and Facilitators

<table>
<thead>
<tr>
<th>Name</th>
<th>Organizations</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jungho Nam</td>
<td>Korea Maritime Institute</td>
</tr>
<tr>
<td>Jiyeon Choi</td>
<td>Korea Maritime Institute</td>
</tr>
<tr>
<td>Woohyun Sophia Choi</td>
<td>Korea Maritime Institute</td>
</tr>
<tr>
<td>Belyn Rafael</td>
<td>Partnerships in Environmental Management for the Seas of East Asia</td>
</tr>
<tr>
<td>Natalie Degger</td>
<td>Partnerships in Environmental Management for the Seas of East Asia</td>
</tr>
</tbody>
</table>
Dr. Junho NAM
Korea Maritime Institute
#26, Haeyang-ro 301beon-gil, Yeongdo-gu, Busan, Republic of Korea
Email: jhnam@kmi.re.kr / jhnam007@gmail.com

Dr. Nam, Junho has been working at Korea Maritime Institute (KMI) since 1996, which is a government-affiliated research entity under the Prime Minister’s Office. His researches cover integrated coastal planning, climate change adaptation, marine environment management, marine ecosystem protection, coastal conflict resolution, transboundary marine environmental affairs, official development assistance, marine science and technology application etc. He has contributed to the formulation of marine policies for his government and establishment of legal and institutional mechanisms for sustainable ocean and coasts. He also has been involved in global and regional environmental issues and their related activities, including land-based activities control, marine debris management, coastal watershed management, transboundary protected areas etc. He contributed to activities of PEMSEA, COBSEA, NOWPAP, YSLME and World Ocean Forum. He served members of National Commission on Sustainable Development and National Commission on Maritime Affairs and Fisheries. He is serving members of National Committee on Coastal Management & National Committee on Land Use Regulation, and has been leading Marine Ecosystem Service Research Network of Korea (MESN Korea).

Prof. Daeseok KANG
Pukyong National University
45, Yongso-ro, Nam-gu, Busan, Republic of Korea
Email: dskang@me.com

Dr. Daeseok Kang is a faculty member of the Department of Ecological Engineering at the Pukyong National University in Busan, Korea. He teaches and does researches in the fields of systems ecology, ecosystem modeling, environmental accounting, ecological economics, and environmental policy. His current research focus is on management strategies and valuation of ecosystem services of marine and coastal ecosystem of Korea. He has served on various advisory committees for government ministries at the national and local levels and the Presidential Committee on Sustainable Development.
Dr. Choong-Ki KIM

Korea Environment Institute
Bldg B, 370 Sicheong-daero, Sejong, 339-007, Republic of Korea
Email: ckbada@gmail.com

Choong-Ki Kim is a research fellow for the division of natural resources conservation in Korea Environment Institute (KEI). His study area includes ecosystem service, nature based tourism, climate change adaptation, and ocean renewable energy. His previous work at Natural Capital Project, Stanford University, was to develop a decision supporting tool, InVEST, to value the benefits from nature. He applied the InVEST models to various decision contexts to inform decisions for sustainable development. He also worked in numerical modeling studies with scales ranging from an estuary to a regional ocean. The focus had been on hydrodynamics, marine water quality, thermal discharge effects, storm surge prediction, transport processes of marine organisms, coupled biological-physical processes, and land-sea interaction.

Experience:
- Working Group Member, Group on Earth Observations-Biodiversity Observation Network (GEO-BON)
- Author for Regional Assessment for the Asia-Pacific, Intergovernmental Platform on Biodiversity and Ecosystem Services (IPBES)

Mr. Jongseo YIM

Seoul National University
#1, Gwanak-ro, Gwanak-Gu, Seoul, Republic of Korea
Email: zero2005@snu.ac.kr

YIM, Jongseo is a PhD student at geography and a fellow of National Global PhD fellowship program. He is skillful with modeling based on Geographic Information System (GIS) and Remote Sensing (RS). Formerly he had worked one and half years as a researcher at Korea Maritime Institute (KMI). During that period, he assisted in researches related to development of marine/coastal environment management and planning. His current research interests lies in spatially explicit approaches that uses scientific and geospatial information to address conflicts and organize human activities in the marine/coastal area, while maintaining ecosystem health, function, and services.
Ms. Hee-Jung CHOI

Korea Maritime Institute
#26, Haeyang-ro 301beon-gil, Yeongdo-gu, Busan, Republic of Korea
Email: chj1013@kmi.re.kr

CHOI, Hee-Jung is the senior researcher of Marine Research Division of Korea Maritime Institute (KMI). Her background lies in geography (BSc) and geographical information system (MSc). She has been involved in development of national coastal and marine policies and formulation of various management plans at national and local levels. She is also participating in activities relevant to national coastal basic survey and coastal information system development. Recently, she has especially an interest in coastal and marine spatial management (or planning) and tools for ecosystem-based marine spatial management (such as spatial decision support systems etc.).

Dr. Gregg Verutes

Natural Capital Project

Gregg Verutes leads the training program which hosts various introductory sessions and technical workshops throughout the world. His current focus is developing innovative techniques that use maps, games, and problem-based exercises to teach students, scientists and practitioners about valuing nature. He also serves as a GIS specialist for the marine team working on coastal zone management in Belize and coastal hazard research throughout the United States. Mr. Verutes received his M.S. from San Diego State University and his B.S. in Policy Analysis and Management from Cornell University.
Ms. Jiyeon Choi

Korea Maritime Institute
#26, Haeyang-ro 301beon-gil, Yeongdo-gu, Busan, Republic of Korea
Email: jychoi@kmi.re.kr

Jiyeon CHOI is an associate research fellow of Marine Policy Research Dept. of Korea Maritime Institute (KMI). This institute is a government-affiliated research entity under the Prime Minister’s Office. Her researches cover coastal and marine spatial planning, ocean zoning, coastline & landscape management, coastal survey & evaluation system, coastal information management etc. She has joined several international cooperation projects regarding integrated coastal management in East Asian Seas and Caribbean Sea. She has actively involved the process of the development of coastal management policies of the Ministry of Oceans and Fisheries and supported local governments developing and implementing coastal management plans and policies.

Ms. Woohyun Sophia Choi

Korea Maritime Institute
#26, Haeyang-ro 301beon-gil, Yeongdo-gu, Busan, Republic of Korea
Email: whchoi@kmi.re.kr

Woohyun Sophia Choi is a researcher at the Marine Research Division of Korea Maritime Institute (KMI). She received her B.A. in International Development Studies from McGill University and her M.A. in Global Environmental Studies (MA) at Sophia University (Tokyo, Japan).
Ms. Belyn Rafael

PEMSEA Resource Facility
Email: brafael@pemsea.org

Ms. Belyn Rafael is currently coordinating the implementation of the SDS-SEA in Cambodia and Lao as well as the implementation of the Joint Communiqué between the UNDP GEF Small Grants Programme and PEMSEA. She has been working with the countries on the development and implementation of the national programs focusing on Integrated Coastal Management and Integrated Riverbasin Management. She has a degree in Journalism, with a Masters on International Studies and currently taking up her Doctoral in Public Administration at the University of the Philippines.

Dr. Natalie Degger

PEMSEA

Dr. Natalie Degger has provided consultancy and technical services to networks of national departments, universities, science institutions and industrial partners involved in marine pollution monitoring and earth observational science. During her time with MERIT, Natalie was involved with the Global Artificial Mussel Watch Program and delivered training to environmental managers and scientists from the International Atomic Energy Agency.

Natalie joined PEMSEA in 2015 on a one-year fellowship where she is involved in activities supporting the UNDP/GEF Scaling up SDS-SEA implementation project. She is also assisting with the GEF/World Bank Medium-sized Project on Applying Knowledge Management to Scale up Partnership Investments for Sustainable Development of Large Marine Ecosystems of East Asia and their Coasts.
Appendix 3:
Trainees of 2nd Training Program
Acknowledgments

We thank all trainees in the 2nd International Training Program on Marine Ecosystem Services Valuation listed below.

<table>
<thead>
<tr>
<th>NAME</th>
<th>Organization</th>
<th>Nation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lyna Khan</td>
<td>Royal University of Phnom Penh</td>
<td>Cambodia</td>
</tr>
<tr>
<td>Sophal Sreng</td>
<td>Ministry of Environment</td>
<td>Cambodia</td>
</tr>
<tr>
<td>Thay Chanta</td>
<td>Ministry of Environment</td>
<td>Cambodia</td>
</tr>
<tr>
<td>Peng Benrong</td>
<td>Coastal and Ocean Management Institute</td>
<td>China</td>
</tr>
<tr>
<td>Qinhua Fang</td>
<td>Coastal and Ocean Management Institute</td>
<td>China</td>
</tr>
<tr>
<td>Rudolf Wu</td>
<td>MERIT</td>
<td>China</td>
</tr>
<tr>
<td>Ye Guanqiong</td>
<td>OC ZU</td>
<td>China</td>
</tr>
<tr>
<td>Luky Adrianto</td>
<td>Bogor Agricultural University</td>
<td>Indonesia</td>
</tr>
<tr>
<td>Yudi Wahyudin</td>
<td>Bogor Agricultural University</td>
<td>Indonesia</td>
</tr>
<tr>
<td>Ario Damar</td>
<td>Bogor Agricultural University</td>
<td>Indonesia</td>
</tr>
<tr>
<td>Alan Koropitan</td>
<td>Bogor Agricultural University</td>
<td>Indonesia</td>
</tr>
<tr>
<td>Jo Yong Chol</td>
<td>N ICM</td>
<td>DPRK</td>
</tr>
<tr>
<td>Choe Ho Jong</td>
<td>KIISU</td>
<td>DPRK</td>
</tr>
<tr>
<td>Ri Kyong Su</td>
<td>MLEP</td>
<td>DPRK</td>
</tr>
<tr>
<td>Yun Kon San</td>
<td>MF</td>
<td>DPRK</td>
</tr>
<tr>
<td>Sengphasouk Xayavong</td>
<td>DWR</td>
<td>Lao PDR</td>
</tr>
<tr>
<td>Monique Sumampouw</td>
<td>World Wildlife Fund</td>
<td>Malaysia</td>
</tr>
<tr>
<td>Vivienne Rhea S. Padura</td>
<td>De Lasalle Lipa</td>
<td>Philippines</td>
</tr>
<tr>
<td>Regina Therese Bacalso</td>
<td>ECO-FISH</td>
<td>Philippines</td>
</tr>
<tr>
<td>Marie Nievales</td>
<td>University of the Philippines, Visayas</td>
<td>Philippines</td>
</tr>
<tr>
<td>NAME</td>
<td>Organization</td>
<td>Nation</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>Norman Emmanuel Ramirez</td>
<td>ASEAN Center for Biodiversity</td>
<td>Philippines</td>
</tr>
<tr>
<td>Porfirio M. Aliño</td>
<td>University of the Philippines, Marine Science Institute</td>
<td>Philippines</td>
</tr>
<tr>
<td>Changsu Lee</td>
<td>National Marine Biodiversity Institute of Korea</td>
<td>RO Korea</td>
</tr>
<tr>
<td>Seunghoon Yoo</td>
<td>Seoul National University of Science &amp; Technology</td>
<td>RO Korea</td>
</tr>
<tr>
<td>Sejun Jin</td>
<td>Seoul National University of Science &amp; Technology</td>
<td>RO Korea</td>
</tr>
<tr>
<td>Bong-Oh Kwon</td>
<td>Seoul National University</td>
<td>RO Korea</td>
</tr>
<tr>
<td>A-reum Han</td>
<td>Anyang University</td>
<td>RO Korea</td>
</tr>
<tr>
<td>Prapsarsiri Barnette</td>
<td>Burapha University</td>
<td>Thailand</td>
</tr>
<tr>
<td>Sakanan Plathong</td>
<td>Prince of Songkhla University</td>
<td>Thailand</td>
</tr>
<tr>
<td>Lince Dessey</td>
<td>UNITAL</td>
<td>Timor Leste</td>
</tr>
<tr>
<td>Mario Tilman</td>
<td>UNTL</td>
<td>Timor Leste</td>
</tr>
<tr>
<td>Mario Cabral</td>
<td>UNTL</td>
<td>Timor Leste</td>
</tr>
<tr>
<td>Peter Mumby</td>
<td>CCRES</td>
<td>The UK</td>
</tr>
<tr>
<td>Tobias Borger</td>
<td>PML</td>
<td>The UK</td>
</tr>
<tr>
<td>Nguyen Son</td>
<td>IET</td>
<td>Vietnam</td>
</tr>
<tr>
<td>Vu Thi Mai Lan</td>
<td>VASI</td>
<td>Vietnam</td>
</tr>
<tr>
<td>Nguyen Bich Ngoc</td>
<td>VASI</td>
<td>Vietnam</td>
</tr>
<tr>
<td>Tu Thi Lan Huong</td>
<td>VASI</td>
<td>Vietnam</td>
</tr>
<tr>
<td>Won Tae Shin</td>
<td>PEMSEA</td>
<td></td>
</tr>
<tr>
<td>Belyn Rafael</td>
<td>PEMSEA</td>
<td></td>
</tr>
<tr>
<td>Natalie Degger</td>
<td>PEMSEA</td>
<td></td>
</tr>
</tbody>
</table>
Partnerships in Environmental Management for the Seas of East Asia

Co-Sponsors

Korea Marine Environment Management Corporation

Co-Organizers

Korea Maritime Institute

Partnerships in Environmental Management for the Seas of East Asia

MINISTRY OF OCEANS AND FISHERIES

PEMSEA

한국해양수산개발원